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Lesson summary
In shallow lakes with a soft bottom, wind waves can easily reach the bottom and resuspend
and mix this bottom material up into the water column. The high turbidity can make these
lakes less attractive for recreation, and for fish and birds that need to see their prey. The high
turbidity also reduces the underwater light intensity and therefore the amount of submerged
vegetation and locations of shelter for macrofauna and prey fish.
In this lesson we Learn how to use satellite data to visualise the effect of wind waves and
other disturbances (such as dredging) in shallow turbid lakes. First, medium resolution
MERIS imagery will be used to study the effect of wind on resuspension. Next, we will have a
look at the added value of high resolution (Formosat, Landsat 8 and Sentinel 2) data.

GLaSS training material outline
This lesson is part of the GLaSS training material. The complete training material outline is
listed on http://data.waterinsight.nl/GLaSS/trainingmaterials/GLaSS_lesson_outline.pdf.
Note that the lessons logically follow up on each other, the later lessons might require skills
that can be acquired during the earlier lessons.
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List of abbreviations
Abbreviation

Description

Chl

Chlorophyll-a

EO

Earth Observation

L8

Landsat 8

NIR

near infrared (>700 nm)

S2

Sentinel-2

S3

Sentinel-3

TSM

Total Suspended Sediments
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1 Introduction
1.1 Resuspension in shallow lakes
Turbid lakes are often shallow and the turbidity is caused by their small (buffering) volume of
water and strong lake-land, air-water and water-sediment interactions. Hence, these lakes
have a high risk to increase in trophic state (eutrophication) and to develop cyanobacterial
blooms. Large wind-exposed shallow lakes are often turbid because lakebed sediments can
be whirled up to the water surface under moderate winds. In case of river inflows that are
dominated by suspended solids, the effect on lake optics is the same as for lakes influenced
by re-suspension events: the backscattering is relatively high and the water therefore
appears bright. The colour of these lakes is generally described as brown to green. High
concentrations of suspended sediments: the reduction of water transparency, and fading of
light in the water column inhibits primary production and survival of many organisms higher in
the food web (Koenings et al., 1990).
Shallow lakes can serve as indicators of climate change. Scheffer et al. (2001) show how
temperature effects driveg ecosystem functioning via the regulation of the steady-state
change in food webs. Also, teleconnections between North Atlantic Oscillation (NAO, a
fluctuation in the pressure systems over the North Atlantic) and wind-driven variation in wave
mixing in Scottish lake have been suggested by Spears and Jones (2010). Variations in the
depth of the wave-mixed layer have previously been shown to affect sediment disturbance
(Eleveld, 2012 and references therein) and internal nutrient loading (Hamilton & Mitchell,
1997).
Examples of shallow lakes with high turbidity due to wind waves or river inflow are Lake
Chad (Chad, Cameroon, Niger, Nigeria), Lake Arresø (Denmark), Lake Boyukshor
(Azerbaijan), Little Wall Lake (Iowa USA), Lake Tana (Ethiopia), Lake Balaton (Hungary),
Lake Markermeer (the Netherlands).

Figure 1. Example of a shallow turbid lake: Lake Chad.
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A different type of lakes with high suspended matter concentrations are glacial lakes (fed by
glaciers). Because of the high mineral versus organic input, they vary in colour from deep
blue to cyan and grey. There is a separate GLaSS lesson about these glacial lakes (Lesson
#7), so those will not be discussed here any further.
Many shallow lakes with high total suspended matter (TSM) concentrations are under
pressure. The shallow lakes in the richer countries are generally used for recreation, while
the lakes in the poorer countries have an important role for fisheries, and sometimes for
hydropower and irrigation. In most lakes the ecosystem services and ecological value are
under pressure, because of eutrophication, reduced light availability due to increased
resuspension. This can be caused by higher fetch (impact of wind),(for example due to
desertification of the surroundings, or decreasing water levels (e.g. due to irrigation or
damming). Shallow lakes can also be impacted by pollution (also by resuspended polluted
sediments), or suffer from a combination of these adverse factors.
Lake management or restoration projects usually aim to bring these lakes from turbid to clear
water state (Scheffer, 1998). Measures to increase the amount of available light in the water
column vary from nutrient management and biomanipulation (such as removal of
benthivorous fish) to hydrologic adjustments (of water level and flushing) or dredging and
creation of enclosures.

1.2 Lake Markermeer – the Netherlands
1.2.1. Status of the lake
Lake Markermeer (Figure 2) is a shallow lake in the centre of the Netherlands.

Figure 2. Map of Lake Markermeer.
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It used to be a part of the original Zuiderzee Sea, and later of Lake IJsselmeer. In 1932 Lake
Ĳsselmeer was created (or: dammed off from the Zuiderzee Sea) by closing of a 32 km long
dam. Next, several polders were created in this new lake. Lake Markermeer came into
existence when a dike (the Houtribdijk) separated the south-western region from the main
lake in 1975. This dike runs from Enkhuizen, southeast to Lelystad. This former southern part
of Lake Ĳsselmeer is now the hydrologically separate Markermeer.
The bottom of Lake Markermeer consists of a layer of mud. Wind waves easily reach the bed
of this shallow lake, and resuspend and mix this bottom material up into the water column,
where we detect it as turbid waters. Because of all the dam and dike building around the
lake, it does not have many natural shorelines. As show in Figure 3, most shores are
relatively steep and have no vegetated gradual underwater slope. Therefore, wind waves are
not gradually dissipated near the shorelines, and resuspension increases. The local influence
of the wind on suspended mater concentrations was studied by Eleveld (2012). Retrieved
surface TSM maps from MERIS imagery matched resuspension maps that were predicted
from wind and water depth.

Figure 3. Photos of Lake Markermeer. Top left: dikes surround Lake Markermeer. Right:
Secchi disk reading showing the high reflection but low transparency. Bottom left: fieldwork at
Markermeer, in the background a harbour full of recreational sailing boats can just be seen.
Interestingly, both TSM and Chl are related to wind speed in Lake Markemeer, and therefore
TSM and Chl also co-vary. A literature study explained this correlation. In Lake Markermeer,
in contrast to other Dutch lakes, the ratio Chlorophyll/Phosphate has increased in the last
decades, following a decrease of the amount of mussels in the lake. Also, the chlorophyll
concentrations increased especially in winter (in the period 1996-2007 in contrast to the
period 1987-1995) (Noordhuis, 2010). The first hypothesis for the increased winter Chl
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concentrations was that these were related to the increased sunshine and water temperature
in winter (Noordhuis, 2010). Noordhuis (2010) also compared the size classes of
phytoplankton. In the period 2002-2006 the amount of phytoplankton small enough to be
grazed by mussels was significantly larger than the 1990's, while the amount of larger
phytoplankton decreased (except for the month October). Especially the very small (< 5 μm),
undeterminable green algae cells in summer increased, due to a decreased grazing by
mussels and/or zooplankton (Noordhuis, 2010). However, while the transparency of Lake
Markermeer had clearly decreased around 1992/1993, it increased again since 2003 (Van
Geest and Noordhuis, 2013). The increase in transparency is expected to be due to the
increase in the number of Quagga mussels that are filter-feeding on suspended matter
including phytoplankton. The mussel beds on the bottom also reduce the sediment
resuspension due to wind (Van Geest and Noordhuis, 2013).
A newer study suggests that floc formation between the smaller algae cells and suspended
sediments has increased, because of changes in the phytoplankton community. These flocs
increase the settling velocity of phytoplankton and therefore decrease the amount of
chlorophyll in the water column during the calmer periods (Van Geest and Noordhuis, 2013).
It has been shown that the cyanobacteria Aphanizomenon, which used to be common, does
not form flocs, while the now common cyanobacteria Aphanothece easily forms flocs with
sediment. This effect explains the higher chlorophyll values in winter (when generally higher
wind speeds occur), the relations between wind speed and chlorophyll, and the co-variance
between Chl and TSM that were found. Van Geest and Noordhuis (2013) conclude that the
floc formation and settling (sinking) of cells, combined with the increased number of mussels
(since 2009) that filter the water and release their pellets at the bottom shifted the main food
webfrom the pelagic to the benthic zone.
1.2.2 Restoration projects
The high TSM concentrations make Lake Markermeer less attractive for recreation, and for
predating fish and birds that need to see their prey. The high turbidity reduces the underwater
light intensity and therefore the submerged vegetation and shelter for macrofauna and prey
fish. It is thought that high TSM concentrations affect the zebra mussels (Dreissena) by
clogging their gills, and that the associated light attenuation impedes the growth of water
plants, whereas algae and (toxic) cyanobacteria thrive at higher TSM concentrations (Van
Duin, 1992; Scheffer, 1998 in Eleveld, 2012). Therefore, measures are being sought to
overcome high turbidity.
In the period 2009-2015, water manager Rijkswaterstaat has carried out a project to study
potential measures to reduce the sediment concentrations in the water column and increase
the biodiversity. During this project several experiments have been set up, including the
setup of a fence to break the waves (Noordhuis et al., 2014). Currently (2015) a new project
by nature organisation Natuurmonumenten is taking off, called Marker Wadden.
Natuurmonumenten will remove the mud layer from the lake bottom and use the material to
create new islands in Lake Markermeer (www.natuurmonumenten.nl/marker-wadden, Figure
4). The dredging will start in 2016.
Earth Observation data can be used to follow trends in turbidity in Lake Markermeer,
especially the effects of the dredging activities and construction works, and to compare the
results with the turbidity before the project started.

7 of 19

Global Lakes Sentinel Services (313256)

Figure 4. Artist impression (top), design (bottom left) and map (bottom right) on the
MarkerWadden project.

1.3 Short intro on specific optical properties
The main substances in the water column that can be detected with optical remote sensing
are: the water itself, phytoplankton pigments, total suspended matter (TSM), and coloured
dissolved organic matter (CDOM). The pigment which is most abundant in marine
phytoplankton is chlorophyll‐a (Chl). Chl, TSM, and CDOM are (indirect) indicators for other
water quality parameters such as nutrient concentration, resuspension and river runoff or
decay of organic material (humus).
Two important effects that substances have on the light entering the water is absorption (like
a sponge does with water) and scattering (like a mirror, but scattering can be in any
direction). Absorption and scattering are called ‘inherent optical properties’.
If “white” sunlight enters the water and it would only be absorbed, no light from the water
would reach the satellite and the water would look black. However, most substances only
absorb specific parts of the visible light, and where one colour of light is absorbed (e.g. red),
the remaining light will let the water appear the residual blue-green colour. The other effect,
scattering, sends the photons in various directions. Part of these are scattered over angles
which are larger than 90 degrees, which is called backscattering. If we assume that this is
the only interaction that these photons have on their pathway, these will finally reach the
satellite and be detected. So for the water to show up as blue/green on a satellite image, the
light has to be scattered, red light is to be absorbed, and green and blue need to get
backscattered.
The effect of the substances mentioned above on water colour are:
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•

Pure water mainly absorbs red light, while the size of the water molecules leads to
scattering of blue light. The colour of deep clear (oceanic) water is therefore blue.
Water absorbs more than it scatters, so very deep water bodies look dark from a
satellite.

•

Chlorophyll mainly absorbs blue and red light, and reflects relatively little, turning the
water green.

•

Inorganic TSM scatters light efficiently and - relatively - spectrally neutral. This high
reflection in combination with absorption of organic TSM, which influences mostly the
blue wavelengths, results in bright water with often high red and NIR reflectance.

•

CDOM absorption spectra are similar to those of organic TSM particles, but CDOM
itself does not scatter. Therefore water with high CDOM concentrations, for example
the Baltic Sea, looks yellow‐brownish and very dark.

Typical absorption spectra are shown in Figure 5. Note that the total absorption by
phytoplankton depends on the concentration and for example the type of phytoplankton that
is present (Stomp et al., 2007). It is possible to determine the absorption of all the
phytoplankton in a sample (as shown in Figure 5), but also to determine for example the
absorption of phytoplankton in a sample per µg Chl. Such specific absorption and scattering
properties of certain substances per unit are called ‘specific inherent optical properties’
(SIOPs). SIOPs can be used to tune complex bio-optical models to retrieve concentrations
from EO data. A reflectance spectrum is than modeled, based on the SIOPs and
concentrations of Chl, TSM and CDOM. The concentrations are changed until the modeled
spectrum is similar to the measured spectrum.

Figure 5. Total absorption by the four main substances influencing the colour of the water,
taken from www.oceanopticsbook.info (2015). Top left: Absorption spectrum for pure water
(data from Pope and Fry, 1992), top right: Generic phytoplankton absorption spectrum for
mixed algal composition (modified from Roesler et al., 1989), for which a large part is due to
Chl. Bottom left: Generic TSM absorption spectrum for mixed composition. Bottom right:
Generic colored dissolved organic matter (CDOM) absorption spectrum for mixed
composition. The spectrum of water absorption increases even more for wavelengths > 700
nm, while the other tree reduce to (almost) zero for wavelengths > 700 nm.
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2 This lesson
2.1 Research question
What is the effect of wind on resuspension in Lake Markermeer?

2.2 Training objectives / skills to gain in this lesson
Learn how to use satellite data to visualise the effect of wind waves and other disturbances in
shallow turbid lakes. Find out about the added value of high resolution data.
1. Use the NIR to analyse the effect of wind on resuspension in lake Markermeer
2. Find out about the added value of high resolution data

2.3 Required software and data
Software and tools
To complete this lesson tasks, the following tools and software are required or suggested:
•

SNAP/BEAM (required, see Lesson #1).
The screenshots in this lesson are based on SNAP, but BEAM can be used too.

Downloadable files
• GLaSS_Training_Lesson6.pdf
The main document of the lesson including exercises and questions.
•

GLaSS_Training_Lesson6_Answers.pdf
A document containing answers to all questions proposed in the exercises.

•

GLaSS_Training_Lesson6_DataAndTools.zip
Supplied data and tools, described below.

The zip-file with supplied data and tools contains:
•

A ‘Original satellite data’ folder containing:
o Three subsets of MERIS imagery in .dim format to check the effect of wind
(e.g.
subset_MER_FRS_1PNUPA20060417_104932_000001012046_00495_2159
1_0613_C2IOP.dim plus additional data folder)
o Two TOA Landsat 8 images in .dim format (e.g. 2014-0917_LC81980232014260LGN00-Markermeer.dim plus additional data folder)
o Five atmospherically corrected Landsat 8 images in .dim format (e.g. 2013-0719_LC81990232013200LGN00-Markermeer_c2rl8.dim)
o Two MERIS images and one Formosat image of March 2012 in .dim format to
see the difference between medium and high resolution imagery (e.g.
FORMOSAT_20120322.dim plus additional data folder)
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o One Sentinel 2 image in its original format:
S2A_OPER_PRD_MSIL1C_PDMC_20151001T124224_R008_V20151001T1
04705_20151001T104705.SAFE
•

A ‘Additional data’ folder containing:
o a colour scale that can be applied to the NIR band: ‘NIR_scale.cpd’

•

A ‘Answer data’ folder containing the same imagery as provided as Original satellite
imagery, after performing the steps that are explained in the lesson
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3 Exercise
Part 1 The effect of wind
We will first have a look at the MERIS satellite data (300 m resolution), that were used in
Eleveld (2012), to see how the wind influences the distribution of TSM in Lake Markermeer.


Start SNAP



Open the MERIS images of 17 April, 10 May, and 11 May 2006 (File > Open Product >>
in the folder MERIS_wind imagery select all .dim files and open them).



To see how the images look like, you can open one or a few bands

As explained in GLaSS Lesson #3, a correction for the atmosphere is usually required to
retrieve valuable data from water surfaces. In GLaSS Deliverable 3.2 (2014), we can find that
the C2R (case 2 regional) atmospheric correction method showed the best results for lake
Markermeer, so this method was already applied for you. (See GLaSS Lesson #3 for more
information on atmospheric correction).
Now we want to derive TSM. By using for example complex bio-optical models, neural
networks or models based on radiative transfer (GLaSS Deliverable 3.4, 2014), the
concentration of TSM can be derived from the measured spectrum. However, this requires to
know the SIOPs (section 1.3), e.g. the specific absorption and scattering of the kind of TSM
that is present in the lake.
To avoid using complex algorithms for this exercise, we will assume that all TSM in Lake
Markermeer has the same properties and not further tune an algorithm. Therefore, we will be
able to know find out where concentrations are higher and lower, without knowing the precise
concentrations. To do this, we need to find out which part of the reflectance spectrum we can
use for this.


Check the absorption plots of the four substances in water (Figure 4). Now add to this
information that pure water scatters mainly in the blue wavelengths, assume that
phytoplankton does not scatter much (it is species dependent, cyanobacteria scatter
substantially) and CDOM does not scatter at all, and that the scattering of TSM is
substantial and spectrally neutral (so, as a horizontal line).



What is the best spectral range to obtain information on the TSM concentration without
the disturbance of other parameters? It might help to fill out a table as the one below,
writing per spectral range which substances have a significant influence on the total
absorption and which on scattering.

Wavelength range (nm)
Absorption by (substance)
Scattering by (substance)

400-500
500-600
TSM, CDOM, Chl

600-700

> 700
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Now we will check the distribution of TSM in the three images.


In the "Product Explorer" window (left side of your screen) click the +-signs to open the
folders for the Metadata, Flag codings, Tie-point grids and Bands. In ‘Bands’ open
‘reflect’ and then ‘reflec_13’ by double clicking it.



Colour Manipulator > Import colour palette from file (the icon with the printer) >>
navigate to the additional data folder > select the NIR_scale > automatically distribute
points: yes. (In other cases you might want to set the colourscale limits such that images
are directly comparable.)
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Do this for all three images, so you can compare the results. You can use the ‘Pixel info’
(the tab next to Product Explorer) to compare the values. After opening the ‘Pixel info’
view just move over the image with your mouse.

o

Which image(s) do you think were acquired during stronger winds? And which image(s)
during lower wind conditions?

o

What were the wind directions?

Keep the MERIS data open for the following part of the exercise

Part 2 The added value of high resolution EO data
MERIS has a pixel size of 300 m square in Full Resolution mode (as used here). This is large
enough for a lake with the size of Lake Markermeer. However, for many smaller lakes, a
smaller pixel size is needed. Also, details in e.g. currents become much more clearly visible
in higher resolution data.
 Have a look again at the MERIS data. Do you have an idea why the distinct lineshaped distribution patter on the south-eastern part of the lake occurs in each image
(see figure below)? (think about it and then move on to the next step)
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Landsat 8 (L8) has a spatial resolution of 30 m for the visible bands. We will use these to see
what kind of details become visible in higher resolution data. The L8 data is also prepared
(area of the lake selected, processed with the C2R atmospheric correction processor).
 Open the Landsat 8 imagery File > Open Product >> in the folder Landsat 8 imagery
– atmospherically corrected, select all .dim files and open them).
 In the Product Explorer, open the reflec_5 bands for all images (note that the central
wavelength of this band is comparable to MERIS band 13, except that the MERIS
band is 20 nm wide and the Landsat band 5 is 30 nm wide).
 Apply the colour scale again analysis (Colour Manipulator > Import colour palette
from file (the icon with the printer) >> navigate to the additional data folder > select
the NIR_scale > automatically distribute points: yes). You can also change the
colourscale limits.
 Use for example the image of the 19th of July to answer the question on the
distribution pattern along the south-eastern side of the lake
o What can explain the extremely high NIR reflectances (an indicator for TSM
concentrations) in the images of 17th September and 10th October 2014?
Note: you can also use the L1 (top of atmosphere, TOA) not atmospherically
processed images to generate RGB composites from the TOA folder. (Window >
Open RGB image view >> it automatically selects Landsat 8)
If you are done, close all images (File > session > close session)
We will now have more detailed look at one of the experiments that was carried out to reduce
turbidity. In 2012, there was a fence build in the north-western part of the lake, which was
partly under and partly above the water. In this case we will use Formosat (www.geoairbusds.com/en/160-formosat-2) high resolution data (8m resolution). We will work with nonatmospherically corrected data, because no easy-applicable atmospheric correction tool is
available Formosat. The intensity of the reflectance of these images can therefore not be
compared with each other, because the atmosphere also contributes to the measured values.
 First, open the two MERIS images from the folder March 2012. Open the NIR bands
(radiance_band_13) and apply the same colour scale again. Use the ‘95%’ button
and move the dark brown sliders to to the left to adjust the colour scale until the
patterns in the water are clearly visible.
 Also open the RGB views of both images (this will help to indicate which patterns are
clouds – something that is automated in most atmospheric correction methods)
o Can you see anything that looks like the fence?
 Now open the Formosat image from the March 2012 folder. Open the NIR band
(band_4). This imageis much broader, and shows more spatial detail than ths of
MERIS and Landsat 8 images. The higher spatial resolution of Formosat comes at a
cost: The spectral resolution is less (so spectrally less precise). Formosat band 4
covers a range from 760-900 nm. Add the same NIR colour scale and adjust the
sliders to visualise the patterns in the water
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 Also open the RGB image view. SNAP does not recognize the sensor, so time you
have to select the three colours yourself

o Does the Formosat image show the fence? Does it make sense that it is not visible in
MERIS data?
o Are there other details visible in Formosat data which are not visible in MERIS data?

And last, check out the Sentinel-2 image, with 10 meter resolution. At the time of writing this
lesson, it is one of the first images that is available. The band B8A at 856 nm is 20 nm wide
and therefore comparable with the NIR band of MERIS. For comparison, you can open this
band and apply the NIR colour scale again and open the RGB image view.
o Do you think these high resolution images can be used to monitor the effects during
and as a result of the restoration project MarkerWadden?
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4 More information and further reading
This lesson is based on the following report:
•

GLaSS Deliverable 5.4, 2015. Global Lakes Sentinel Services, D5.4: Shallow lakes
with low transparency due to resuspension. WI, CNR, VU/VUmc. Available via:
www.glass-project.eu/downloads

The report is suggested for further reading. It contains processed data for other shallow lakes
with high sediment concentrations and their own typical problems:
•

Lake Böyük Şor (Azerbaijan), where a restoration project is followed using EO data

•

Himalayan lakes (Nepal), were EO data is used in the process to find the lakes that
can potentially cause harmful Glacial Lake Ourburst Floods (GLOF)

For more information on GlaSS, and to download all public reports: www.glass-project.eu.
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